Guidelines for Creating Accessible Documentation

Last Revised: 08/27/08
Final 08/27/08
# REVISION CONTROL

<table>
<thead>
<tr>
<th>Document Title:</th>
<th>Guidelines for Creating Accessible Documentation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Author:</td>
<td>ITS Project Management Office, Documentation</td>
</tr>
<tr>
<td>File Reference:</td>
<td>Guidelines for Creating Accessible Documentation 20080827.docx</td>
</tr>
</tbody>
</table>

## Revision History

<table>
<thead>
<tr>
<th>Revision Date</th>
<th>Revised By</th>
<th>Summary of Revisions</th>
<th>Section(s) Revised</th>
</tr>
</thead>
<tbody>
<tr>
<td>08/27/08</td>
<td>J Lussier</td>
<td>Release of New Document</td>
<td>N/A</td>
</tr>
</tbody>
</table>

## Review / Approval History

<table>
<thead>
<tr>
<th>Review Date</th>
<th>Reviewed By</th>
<th>Action (Reviewed, Recommended or Approved)</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Table of Contents

Campus Note..................................................................................................................................................4
Introduction ...................................................................................................................................................5

1.0 Heading Levels and Styles ...................................................................................................................5
   1.1 Heading Styles Delivered in CMS Templates ....................................................................................6

2.0 H-Subtitles ..............................................................................................................................................8

3.0 Lists ........................................................................................................................................................9
   3.1 Lists, Using Bullets ..............................................................................................................................9
       List Bullet ...........................................................................................................................................9
       List Bullet 2 _ Whole List Indented ..................................................................................................9
   3.2 Lists, Using Numbers ..........................................................................................................................10
       List Number .......................................................................................................................................10
       List Number 2 _ Whole List Indented .............................................................................................10

4.0 Tables ....................................................................................................................................................10
   4.1 Table Styles ........................................................................................................................................11
       4.1.1 Activating the Repeat Header Rows Command .......................................................................11

5.0 Alt Tags and Screen Shots ....................................................................................................................12

6.0 Styles Provided for Use with Instructional Screen Shots ..................................................................13
   6.1 The Two-Column Instructional Table .............................................................................................13
   6.2 Screen Shots – No Columns .............................................................................................................14

7.0 For Assistance .......................................................................................................................................14
Campus Note

The Guidelines for Creating Accessible Documentation contains general guidelines for producing accessible documentation, as well as specific instructions for use of CMS-delivered templates. Although many details of the guide are geared towards use by CMS Central staff, the principles apply to the creation of any print documents. In addition, the CMS templates and embedded stylesheets are available for use by any campus. Feel free to download this guide and our CMS templates for further use and/or customization at your campus.

Document templates based on the stylesheets demonstrated in this guide are posted to the CMS website at: http://cms.calstate.edu/03_SubmissionFormsTemplates/index.asp

CMS General Use Templates

The following templates have been built using style definitions and stylesheets that have been tested against accessibility standards.

Cover Page and TOC (Microsoft Word)
Use these templates when you are creating a multiple page document that requires a cover page and table of contents.

- Numbered Headings (1.0 2.0 )
- Unnumbered Headings

Single-Page (Microsoft Word)
Use this template when a simple 1-2 page template is required. Examples for use of this document include executive summaries and overviews.

- MSWord Portrait

The following templates do not deliver embedded stylesheets, like those found in Microsoft Word templates. When using these templates, please refer to the Excel and Powerpoint resource links, as posted to the CO Accessible Technology website.

- Excel Portrait | Landscape
- Powerpoint Presentations

Custom Templates

In addition to general use templates, CMS publishes custom templates that support specific deliverables such as maintenance pack releases, bulletins, business process guides, configuration guides, etc. CMS is currently in the process of converting all of these templates and each will be republished to the CMS website as they are converted and tested for accessibility.
Introduction

Creating accessible documents relies on a few basic design principles that allow documents to interface properly with screen readers and other accessibility tools. This guide provides an explanation of the design principles to follow and demonstrates how to easily apply the standards using the built-in features of CMS templates.

The design principles covered in this document include:

- Heading Levels and Styles
- Tables
- Lists
- Alt Tags and Screen Shots

1.0 Heading Levels and Styles

Screen readers and other accessibility tools rely on the use of HTML tags and levels to create “readable” document structure, and creating the required structure in Microsoft Word is accomplished through the use of styles. Therefore, in order to make documentation accessible, it is important to understand the relationship between styles, levels and HTML tags.

The purpose of generating heading tags is to generate links that are recognizable by assistive devices. For example, a Heading 1 style generates an `<h1>` HTML tag and Level One hyperlink. Assistive technology tools turn heading levels into hyperlinks by reading the HTML tags, thus providing “hooks” for users to quickly scan documents for specific information. Users can select to browse (for example) only Level 1 Headings so they can begin reading only where they want to within the document. Without these “hooks” screen readers just start reading at the beginning of a document and go straight through.

The following table illustrates the relationship between styles, HTML tags and levels. The table is provided for illustrative purposes only; not all CMS styles are shown.

<table>
<thead>
<tr>
<th>Heading Style</th>
<th>HTML Tag</th>
<th>Level</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.0 Heading One</td>
<td><code>&lt;h1&gt;</code></td>
<td>Level One</td>
</tr>
<tr>
<td>body text body text body text body text body text body text body text body text body text body text body text body text body text body text body text</td>
<td></td>
<td></td>
</tr>
<tr>
<td>1.1 Heading Two</td>
<td><code>&lt;h2&gt;</code></td>
<td>Level Two</td>
</tr>
<tr>
<td>body text body text body text body text body text body text body text body text body text body text body text body text body text body text body text</td>
<td></td>
<td></td>
</tr>
<tr>
<td>1.1.1 Heading Three</td>
<td><code>&lt;h3&gt;</code></td>
<td>Level Three</td>
</tr>
<tr>
<td>body text body text body text body text body text body text body text body text body text body text body text body text body text body text body text</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
1.1 Heading Styles Delivered in CMS Templates

CMS templates deliver a total of eight heading styles, utilizing three levels. While all styles are listed here, it should be noted that individual templates are customized to include only subsets of styles relevant to the individual template’s design.

CMS heading styles are linked to levels and will generate the appropriate html tags when the documents are posted as html or pdf files. To ensure accessibility, users are asked to only use delivered heading styles, and not create new ones without consulting a member of the Training and Documentation team.

Level One

- Heading 0_No TOC-Gray
- Heading 0_No TOC-Red
- Heading 0_TOC- Gray
- Heading 0_TOC-Red
- Heading 1

Level Two

- Heading 2

Level Three

- Heading 3
- Heading 3_No Numbers

⚠️ It is very important to use only the delivered Headings, and not to exceed the three levels.

Subtitles

If further subdivisions are needed within sections, there are four additional styles provided that will allow users a wide range of flexibility in including subtitles – but that will not show up as heading levels in accessibility screen readers. This design is intentional – to limit the amount of information that is “chunked” into headings. If too many levels are provided, it defeats the purpose of organizing the information and ends up providing a not-very-useful long, long list of hyperlinks that are cumbersome to navigate through in a screen reader.

The subtitle styles provided for use in CMS templates that are not coded as headings are:

*H-Subtitle 01_Italics*

*H-Subtitle 02_Bold*

*H-Subtitle 03_Underlined*

*H-Subtitle 04_Bold and Underlined*
The following demonstrates use of the heading and subtitle styles created for use in CMS templates.

### Heading 0_TOC-Red

### Heading 0_TOC-Gray

These two styles are typically used for Introductions and Appendices – where you want the title to show up in your Table of Contents, but you do not want it to have numbers. This style is associated to the Heading 1 level, and will show up in screen readers. Not all templates will have both styles available in the style sheet, depending on the custom design of the individual template.

### Heading 0_NoTOC-Red

### Heading 0_No TOC-Gray

These two styles are also associated to the Heading 1 level, so they will be read by screen readers, but they have been coded not to show up in the Table of Contents (TOC) in the document. These two styles are much less frequently used than the versions that do show up in the TOC. They are typically used only in very complex sections where you do not want to start numbering over again, but nevertheless want a visual separator for a “side bar” (related) piece of information that does not warrant a new section in the TOC.

### 1.0 Heading 1

- **Template Style A: Numbered Headings**
  
  For templates delivered with numbered headings, **Heading 1** will have numbering already built into the heading style. This style is used very frequently throughout CMS document templates, for example in Business Process Guides, Configuration Guides, and Design Specifications.

  Users should never click the number shortcuts in the toolbars to generate numbers, as it will throw off all features of the styles.

  *Screen shot of the number shortcuts in the Microsoft Word 2007 Paragraph Toolbar*

- **Template Style B: Unnumbered Headings**
  
  For templates delivered with unnumbered headings, **Heading 1** will *not* have any numbering built in, and the Heading 0_TOC-Red style will be disabled – since it has the same features as an unnumbered Heading 1. The unnumbered heading style is used most frequently for single-page templates and executive summaries.
1.1 Heading 2

- **Template Style A: Numbered Headings**
  For templates delivered with numbered headings, **Heading 2** will have numbering already built into the heading style.

- **Template Style B: Unnumbered Headings**
  For templates delivered with unnumbered headings, **Heading 2** will **not** have any numbering built in.

1.1.1 Heading 3

- **Template Style A: Numbered Headings**
  There are some occasions when only two levels of numbering are necessary – but where you do want a third level of information to show up in the Table of Contents (TOC). Thus, for templates delivered with numbered headings, users can select either **Heading 3** (which is numbered) or **Heading 3_No Numbers** for a third level heading. Both are defined and associated to Level 3 tags, and both will show up in the document’s TOC.

  **Heading 3_No Numbers**
  **Heading 3_No Numbers** is frequently used in Business Process Guides and Configuration Guides where the sections consist of only a few steps and using numbers would be overkill – i.e. 1.2.1, 1.2.2, 1.2.3, 1.2.4 ……1.2.18, 1.2.19, etc. – each with only a few lines of body text under each step. As a rule of thumb, where there are multiple small steps underneath a Level Two, it is generally better not to use numbers for Level Three.

- **Template Style B: Unnumbered Headings**
  For templates delivered with unnumbered headings, **Heading 3** will **not** have numbers, and thus **Heading 3_No Numbers** will not be available in the stylesheet since it would be duplicative.

2.0 H-Subtitles

Heading subtitles (H-Subtitles) can be used to provide additional subcategories that will **not** show up in a TOC or as an accessibility reader hyperlink. Subtitles are designed to have the same point size as body text so they will not stand out as a heading but will still show added emphasis.

**Subtitle 01_Italics**
Please use this for all navigation paths above screen shots and for descriptive text to introduce tables.

**Subtitle 02_Bold**
Use whenever you have the need for subtitles within a section that you do not want showing up in a TOC.

**Subtitle 03_Underlined**
Use whenever you have the need for subtitles within a section that you do not want showing up in a TOC.

**Subtitle 04_Bold and Underlined**
Use whenever you have the need for subtitles within a section that you do not want showing up in a Table of Contents. Please note – this style is exactly the same as Heading 3 – but the difference is that it is not tied to a Table of Contents – and is also not tied to any Level codes – so accessibility readers will just read it as body text, not as a part of an outline.
3.0 Lists

There are four styles delivered to create lists in CMS templates.

- **List Bullet** provides bullets that are flush to the left-hand margin.
  - **List Bullet 2_Whole List Indented** provides bullets that indent the whole starting margin by ½ inch.

1. **List Number** provides a numbered list that is flush to the left-hand margin
   1. **List Number 2_Whole List Indented** provides a numbered list that indents the whole starting margin by ½ inch.

When you create lists **DO NOT** use the shortcuts provided in the Paragraph Toolbar to create the list. Instead, choose one of the built-in styles delivered in the CMS templates. Using the toolbar does not set the proper fonts or indents.

*Table showing graphic of Microsoft Word Paragraph Toolbar*

- **DO NOT** click the buttons in the toolbar to create bullet lists or numbered lists.
- **However, once you have created the bullet or numbered list by choosing the styles provided, you can use the indent button (or your Tab key) for indentation.**

3.1 Lists, Using Bullets

The following provides samples of how the two bullet styles appear when using multiple levels of indents.

**List Bullet**

- This is the **List Bullet** style. Notice that the bullets start all the way out to the left margin of the document.
  - This uses the Tab Key to indent once for a second level of bullets.
  - This uses the Tab Key to indent twice to a third level of bullets.

**List Bullet 2_Whole List Indented**

- This is the **List Bullet 2_Whole List Indented** style. Notice that the first level is indented. This style is used when you want to indent your whole list and is set up to align underneath the delivered Heading styles.
  - This uses the Tab Key to indent once for a second level of bullets.
  - This uses the Tab Key to indent twice for a third level of bullets.
3.2 Lists, Using Numbers

The following provides samples of how the two numbered list styles appear when using multiple levels of indents.

**List Number**
1. This is the List Number style. Notice that the bullets start all the way out to the left margin of the document.
   A. This uses the Tab Key to generate a second alpha-numeric level
      i. Hit the Tab Key again to generate the third alpha-numeric level

**List Number 2 Whole List Indented**
1. This is the List Number 2 Whole List Indented style. Notice that the first level is indented. This style is used when you want to indent your whole list
   A. This uses the Tab Key to generate a second alpha-numeric level
      i. Hit the Tab Key again to generate a third alpha-numeric level

4.0 Tables

In order to make tables accessible to screen readers, three conditions must be met:

1. All tables must contain a header row
2. The header row has to be given the command to “Repeat as Header Row on Each Page”
3. The table structure must be set up with unique information for each column. In other words, only one type of information should be contained in each column, and the column header must clearly state what the information in that column is.

Following are two examples of simple and complex table structures.

**Accessible (Simple Tables)**
Notice in this table, the heading refers to the information found in each column. It is CMS policy to only use these types of tables for any tables added to documents by authors.

<table>
<thead>
<tr>
<th>Date</th>
<th>By</th>
<th>Action</th>
<th>Section(s) Altered</th>
</tr>
</thead>
<tbody>
<tr>
<td>00/00/00</td>
<td>A. Last Name</td>
<td>Updated screen shots to reflect upgrade</td>
<td>1.0, 1.1</td>
</tr>
<tr>
<td>00/00/00</td>
<td>B. Last Name</td>
<td>Added new process for submitting PO changes</td>
<td>7.0</td>
</tr>
</tbody>
</table>

**Limited Accessibility (Complex Tables)**
This is an example of a complex table that screen readers will find harder to decipher unless features are incorporated into the table to define reading order and/or to use fields instead of cells. In cases where complex tables are delivered in CMS templates, they have been developed with a defined reading order and incorporate the use of fields instead of cells, where appropriate. Authors without advanced training in Microsoft Word and accessibility conversion should not add complex tables to documents.

<table>
<thead>
<tr>
<th>Date</th>
<th>Location</th>
</tr>
</thead>
<tbody>
<tr>
<td>Time</td>
<td>Dial In Information</td>
</tr>
<tr>
<td>Meeting Called By</td>
<td>Meeting Purpose</td>
</tr>
</tbody>
</table>
4.1 Table Styles

Four text styles are built into CMS document templates for use in tables:

**Table 01_Header**
Use for the first row – the table header row.

**Table 02_Body** or **Table 03_Bulleted List** or **Table 04_Numbered List**
Use any of the three table styles, depending on whether you need plain body text, a bulleted list, or a numbered list within the table.

Remember, the first row of each column must be labeled with a title for the information that will be found in each column and must have the table header command Repeat Header Rows activated.

<table>
<thead>
<tr>
<th>Table 01_Header</th>
<th>Table 01_Header</th>
<th>Table 01_Header</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Table 02_Body</strong></td>
<td><strong>Table 03_Bulleted List</strong></td>
<td><strong>Table 04_Numbered List</strong></td>
</tr>
</tbody>
</table>
| Body text in the table has its own style because it is compressed more to fit in the tight spaces needed for table columns. Thus, be sure to pick the Table 02_Body for use within the columns, not just the plain Body Text. | - Level One
  - Level Two
    - Level Three | 1. A. Level Two
  2. Level One
  A. Level Two
    - Level Three |

**NOTE:** When working with lists inside of tables, you cannot use the Tab key to indent the levels – instead, you must use the indent button on the Paragraph Toolbar.

4.1.1 Activating the Repeat Header Rows Command

*In Word 2007, follow these steps to add the command “Repeat Header Rows” for the first row of each table.*

<table>
<thead>
<tr>
<th>Instructional Step</th>
<th>Screen Shot</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Highlight the first row of the table</td>
<td><img src="image" alt="Table 01_Header" /></td>
</tr>
<tr>
<td>2. Click the “Layout” Tab</td>
<td><img src="image" alt="Table Tools" /></td>
</tr>
<tr>
<td>3. Select the “Repeat Header Rows” command</td>
<td><img src="image" alt="Repeat Header Rows" /></td>
</tr>
</tbody>
</table>
5.0 Alt Tags and Screen Shots

All screen shots must be labeled with Alternative Text (alt tags) in order to make them accessible to screen readers. Screen readers cannot read the information contained within graphics, so a clear description of the information contained in the graphic must be provided in the alt tag. In addition to using alt tags, all relevant information must be provided in the body of the text, not just in the picture. This is especially important when providing instructional materials. If the instructions rely on the information in a graphic to illustrate a step, it will not be read by a screen reader, and thus will provide incomplete instructions. Graphics can illustrate an instructional step, they cannot replace one.

Procedure to add alt tags in Microsoft Word 2007

<table>
<thead>
<tr>
<th>Instructional Step</th>
<th>Screen Shot</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Place the screen shot in the document</td>
<td>![Diagram of Picture Tools &gt; Format Tab]</td>
</tr>
<tr>
<td>2. Select the screen shot by clicking on it</td>
<td>![Diagram of Size arrow highlighted in red]</td>
</tr>
<tr>
<td>3. Click the Picture Tools &gt; Format Tab</td>
<td>![Alternative Text window]</td>
</tr>
<tr>
<td>4. Click on the Size arrow, shown here outlined in Red. <strong>The Alt Text window will launch</strong></td>
<td>![Size and Alt Text window]</td>
</tr>
<tr>
<td>5. Enter the alternative text for the graphic in the window provided on the Alt Text tab</td>
<td>![Screen shot of Size arrow, outlined in red for emphasis]</td>
</tr>
</tbody>
</table>

⚠️ **IMPORTANT TIP:** When you use red boxes or circles to highlight information on a screen shot, use Snag It to take a screen capture AFTER you have added the red boxes and/or other highlights. Then add the ALT TAG to the screen shot. Otherwise, if not done that way, you have to provide an ALT TAG for every red box, line, circle, etc.
6.0 Styles Provided for Use with Instructional Screen Shots

6.1 The Two-Column Instructional Table

Two-column tables are used to provide users with a set of short instructional steps, alongside a screen capture.

Things to remember:

1. Use **H-Subtitle 01_Italics** to place a descriptive sentence or navigation path above the table. The text should introduce at a high level what information will be found in the table.

2. Use **Table 01_Header** as the style for the first row of the table. Label the left column **Instructional Step**; label the right column **Screen Shot**. Make sure to add the command “Repeat as Header Row” to the top column (see Section 4.1.1)

3. The instructional steps on the left must match the picture on the right. Add additional cells if you are adding more screen shots so that you can easily match up the steps to the graphics.

4. See the example shown below of how the descriptive text provided in the alt tag elaborates on the instructions, but does not replace the instructions. The instructions are clearly outlined in the left-hand column.

*The following table provides an example of ‘best practices’ for table design. The numbers outlined with a Red Text box are provided to match up with the instructional steps provided above.*

<table>
<thead>
<tr>
<th>Instructional Step</th>
<th>Screen Shot</th>
</tr>
</thead>
<tbody>
<tr>
<td>6. Place the screen shot in the document</td>
<td><img src="image" alt="Screen Shot" /></td>
</tr>
<tr>
<td>7. Select the screen shot by clicking on it</td>
<td><img src="image" alt="Screen Shot" /></td>
</tr>
<tr>
<td>8. Click the Picture Tools &gt; Format Tab</td>
<td><img src="image" alt="Screen Shot" /></td>
</tr>
</tbody>
</table>

This is what is entered as the alt text:

*Screen Shot of the Picture Tools - Format Tab with handles visible, showing that the picture is selected.*

- Notice that the description clearly states what the picture shows, and that all instructional steps are actually contained in the left-hand column.

**Styles to Use in the Table**

Use **Table 03_Bulleted List** or **Table 04_Numbered List** to provide the instructional steps. Then, use the **Screen Shot 02_in Table** style to line up the screen shots in two-column instructional tables. Just select the whole right hand column (after the first header row) and apply the style. The screen shots will all align right and then can be resized to fit the column.
6.2 Screen Shots – No Columns

When including screen shots directly in the text of your document, and not in a two-column format, please use the following standards:

Use **Body Text_Arial** for introduction text. Then, enter a navigation path before the screen shot, as shown.

\textit{path > path > path > path > Subtitle 01_Italics}

Please Note: The border around the picture is NOT a table – it is just a border built right into the style. To place the border around your screen shot, just choose the style: **Screen Shot 01_Full Page**

7.0 For Assistance

For assistance with modifying templates, or for receiving training, please contact any of the following members of the ITS Project Management Office Documentation team.

**Jeanine Lussier**  
Director, ITS Documentation Standards and Training  
562-951-4326  
jlussier@calstate.edu

**Elmo Carino**  
HR and Finance Documentation Specialist  
562-951-4240  
ecarino@calstate.edu

**Julie Maiorana**  
SA Documentation Specialist  
562-951-4336  
jmaiorana@calstate.edu